Introduction to Planning:

PennPlan & Reports
# TABLE OF CONTENTS

Getting Access ..................................................................................................................... 4

Web-Based Training ................................................................................................................. 4

Getting Started .................................................................................................................... 5

Browser Settings ................................................................................................................ 5
Installing Hyperion Server SSL Certificates ........................................................................ 6
Launching the Planning Application ....................................................................................... 6
Password Security ............................................................................................................... 7
Budget Planning Users - Support ......................................................................................... 7

System Overview ................................................................................................................. 8

Applications and Instances.............................................................................................. 8
Data Sets ............................................................................................................................. 9
Dimensions ......................................................................................................................... 9

Setting PennPlan User Preferences .................................................................................. 11

Number Signage ............................................................................................................... 13
User Interfaces .................................................................................................................... 13

Hierarchies and Penn’s Chart of Accounts ...................................................................... 16

Organization (ORG) Hierarchy ...................................................................................... 17
Fund Hierarchy .................................................................................................................. 18
Program (PROG) Hierarchy ............................................................................................ 20
Center Reference (CREF) Hierarchy ................................................................................ 21
Object Code (OBJ) Hierarchy ........................................................................................... 21

Budgeting Revenue and Expense .................................................................................... 22

Data Entry Forms ............................................................................................................. 22

Budgeting Personnel ........................................................................................................ 24

What Types of Personnel Are Included? .......................................................................... 24
“Anyone or No One” ........................................................................................................... 24
Salary Forms ...................................................................................................................... 25
Pre-Populated Data for Forecast and Budget ................................................................. 26
Calculations for Forecast and Budget ............................................................................... 26
Planning Maintenance Schedule ....................................................................................... 27

Using Reports ................................................................................................................... 27

Setting Report Preferences ............................................................................................. 28
Running Reports ............................................................................................................... 29
Getting Access

Users gain access to the planning applications by:

1. Submitting an access form. Access forms (and instructions for filling them out) are available on the Planning web page http://www.upenn.edu/computing/isc/apps/budget/. Please return the signed form to the Budget Office.

2. Completing the User training. Penn has contracted with Hyperion to use their web-based user training. The web training is accessible as optional training on Penn’s Learning Management System known as Knowledge Link. A hyperlink on the Planning website will launch Knowledge Link.

3. Reviewing this Penn specific documentation. The user training is generic for all Hyperion customers. This document defines the Penn language, terminology and other specifics about the Penn installation of the Hyperion planning tools.

Web-Based Training

Hyperion’s web based training tool allows users to learn how to use the Planning software at their own pace and on their own schedule. This also provides an on-going opportunity for new users to get up to speed on the system, or for users to come back for refresher training as needed. The training is not specific to Penn, however, and includes some features that are not a part of the Penn installation. Penn is not using Hyperion Smart View, for example, and only budgets in $US. You may skip those sections, and “fail” that part of the assessment.

The training consists of the following modules:

Module 1 - Introducing Hyperion Planning
Module 1 - Assessment

Module 2 - Getting Started with Forms
Module 2 - Entering Data in a Form
Module 2 - Creating Plans Using Hyperion Smart View (skip)
Module 2 - Promoting Plan Data for Review
Module 2 - Assessment

Module 3 - Adjusting and Annotating Data Values
Module 3 - Adding Supporting Detail
Module 3 - Assessment
Each module consists of a number of lesson plans followed by an assessment. Lessons are narrated, but text is provided on each page of the lesson plan. Users have the opportunity to try out examples in many lesson plans. The lessons can be paused, replayed and the narration can be silenced.

Each module is followed by an assessment. The multiple choice and true/false questions are fairly straightforward. However, some assessments require you to use the software to complete a specific task. These tasks can be the most frustrating portion of the training, because the assessments are very unforgiving in judging what is right and what is wrong. The tasks need to be completed in the expected order, with no stray mouse clicks or movements. The task may expect that you scroll by clicking on the down arrow instead of the scroll bar, and will count the exercise as incorrect if you deviate in this slight manner. It will tell you what the correct steps are. If you can confirm from the steps they specify that you understand how to do that task, you do not need to take the test over and over to get the mouse movements in the correct order. Simply go on to the next lesson.

Group training sessions will also be offered that utilize the web-based training in a proctored session, in which a member of the budget office staff will be available to answer questions. To register for the proctored sessions, go to Knowledge Link.

**Getting Started**

**Browser Settings**

Planning is a web-based application. As such, it is important that users ensure their web browser settings are configured appropriately. Specifically:

- All pop-up blockers should be disabled.
- The browser should be set to “Refresh the page” on every visit to the page.

In the cases mentioned, these settings are identical to the default configuration for BEN Financials, so unless you’ve manually changed one of those settings, you should not need to specifically adjust them.
Installing Hyperion Server SSL Certificates

The first time you log into Planning or Reports, you'll need to add the server's SSL certificate to your PC. This involves the following steps:

1. Point your browser to https://berks.mr.isc-seo.upenn.edu/HyperionPlanning/ (for Planning) or https://berks.mr.isc-seo.upenn.edu:8443/hr/ (for Reports). In the Security Alert window that appears, click “View Certificate”.
2. Click the “Install Certificate” button in the certificate information window (the server listed will actually be berks.mr.isc-seo.upenn.edu).
3. The Certificate Import Wizard appears; click “Next” to proceed through the wizard.
4. Click “Next” to automatically select the certificate store.
5. Click “Finish” to complete the wizard.
6. Click “Yes” in the Security Warning window to install the certificate.
7. Click “OK” to acknowledge the “import was successful” message.
8. Click “OK” and “Yes” to close the Certificate and Security Alert windows. You should then be directed to the application logon page.

Launching the Planning Application

The starting point for Planning is the URL: http://www.upenn.edu/computing/isc/apps/budget/. This webpage provides hyperlinks that launch Penn’s implementation of Hyperion Planning (“PennPlan”) and Hyperion Reports (“Reports”). Hyperion Planning provides tools to create forecasts and budgets. Reports contain all historical information and is the principal reporting tool.
Users can have open sessions of both PennPlan and Reports at the same time as long as the two are launched in separate browser windows.

**Password Security**
Use the Password Manager link and your PennKey ID and password to set your Planning password. Please remember that although we intend to link the Planning IDs and passwords to your PennKey IDs and password, the link is not yet automatic. In the interim, we recommend that you make your Planning password the same as your PennKey password, and change one if you change the other. Security levels are authorized by the management team of the School and Center and are generally set to provide the same level of access as in Ben Financials and Salary Management.

---

**Budget Planning Users - Support**
For PennPlan & Reports, there is a PDF manual.

- The link for the manual is: 
  [http://www.upenn.edu/computing/isc/apps/budget/training.html](http://www.upenn.edu/computing/isc/apps/budget/training.html)

In PennPlan or Reports, users can look for answers to common questions about using Hyperion Planning on the Web.

- Hit the Help button on the Menu Toolbar > Contents, then select Frequently Asked Questions.

Users can also direct questions or report errors by email to PlanningHelp-L@lists.upenn.edu.

- When users email the help list for support, email is directed to a support team, rather than an individual. One of the team members will respond soon, and all of the support team will know who
is fielding the problem. This method also will help the team to document questions and errors.

- When asking for help or reporting an error, it would be extremely helpful to document the message by taking a print screen (shift Print Screen/SysReq key) and pasting it into a word document, which you should attach to the email. In the word document, also note the date and time of the error, what you were doing and what you expected to have happen, what happened instead, and which org, fund, object (and where applicable, employee) you were using, and which version (final or working), scenario (budget, actual or forecast), year, and timeperiod (Yeartotal or January) you were looking at. This will help the support team to reproduce and troubleshoot any errors.

**System Overview**

**Applications and Instances**

Planning data for the University have been separated into three separate planning instances in order to improve user system performance. Individuals must select the appropriate instance of Planning using the Application pull-down menu. Only one PennHist (reporting) instance exists and contains data for the entire University.

<table>
<thead>
<tr>
<th>Application/Instance</th>
<th>Information Available</th>
<th>Organizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>PennPln1</td>
<td>Working Forecast (to update)</td>
<td>School of Medicine</td>
</tr>
<tr>
<td></td>
<td>Working Budget (5 years) (to update)</td>
<td>School of Dental Medicine</td>
</tr>
<tr>
<td></td>
<td>Previous Spring submission for comparison</td>
<td>School of Veterinary Medicine</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PennPln2</td>
<td>Working Forecast (to update)</td>
<td>Remaining Schools</td>
</tr>
<tr>
<td></td>
<td>Working Budget (5 years) (to update)</td>
<td>University Museum</td>
</tr>
<tr>
<td></td>
<td>Previous Spring submission for comparison</td>
<td>Provost Administrative Center</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provost Interdisciplinary Center</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PennPln3</td>
<td>Working Forecast (to update)</td>
<td>Remaining Resource Centers</td>
</tr>
<tr>
<td></td>
<td>Working Budget (5 years) (to update)</td>
<td>Remaining Administrative Units</td>
</tr>
<tr>
<td></td>
<td>Previous Spring submission for comparison</td>
<td>Auxiliary Enterprises</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PennHist</td>
<td>Actuals (5 years previous years)</td>
<td>All ORGs in the University of Pennsylvania</td>
</tr>
<tr>
<td></td>
<td>Current Year Original Budget (“Final” Budget)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current Year to Date Actuals (closed months)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working Forecast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working Budget</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Previous submissions for comparison</td>
<td></td>
</tr>
</tbody>
</table>
Data Sets
Each PennPlan Instance provides forms that allow input into two separate data sets. Each form will display a data set appropriate for that form.

- Penn Plan Revenue and Expense ("PennPlan RevExp")
  The Penn Plan Revenue and Expense data set contains a total of six years of data: Original Budget (the Spring Budget) and Forecast for the current fiscal year (CY), and Budget for the next five fiscal years (NY1 through NY5). Each planning form allows the user to access three scenarios. The user can review the current year original budget, update the current year forecast, and update the 5-year budget entries. Planning users are always entering information into the Working Version of Planning. Time-stamped snapshots of planning data are available through PennHist so that a user can review different iterations (Winter, Spring, Summer, and Fall iterations). The final version, available through PennHist, refers to the timed snapshot that was used to feed the General Ledger.

- Penn Plan Salary Detail ("Salary Detail")
  The Penn Plan Salary Detail data set covers the same time period as the Revenue and Expense data set, but it contains the individual person-level detail for those periods for Schools and Centers that have chosen to budget salaries by individual. The data set contains salary information at the ORG, FUND, PROG, CREF, OBJ levels for Schools and Centers that have chosen to budget salaries at the aggregate level by using the employee “anyone or no one” for the salary lines.

These data sets are combined in the Reporting application:

- Penn History ("PennHist")
  Available only through the Reports application, the Penn History data set provides all of the data from Penn Plan Revenue and Expense, Penn Plan Salary Detail, plus actual revenue and expense for four additional closed fiscal years. Snapshot budget and forecast data from the various planning versions (Fall, Winter, Spring, and Summer) are also available through PennHist.

The forecast and budget data in the Penn Plan Revenue and Expense data set will be populated to the Penn History data set on a regular basis, a minimum of once per day. Changes to the Penn Plan Salary Detail set will affect the Revenue and Expense data set totals; those changes will also be populated to the Penn Plan data set and to the Penn Hist data set on a regular basis, a minimum of overnight. See the Planning web site, http://www.upenn.edu/computing/isc/apps/budget/ for the current schedules.

Dimensions
Hyperion Planning organizes the planning data through the use of dimensions. Penn’s planning application translates the University’s chart of accounts into applicable dimension fields. Each PennPlan instance is loaded with the same types of metadata and the same forms. Metadata refers to the data about the data, and includes the lists of valid values, such as the allowable choices for Penn’s 26-digit
chart of accounts, and the relationships between the values, such as how they are rolled up into summaries. These values are typically defined in a hierarchical format such as the RCM Object tree or the University Organization Hierarchy and are similar to the Hyperion dimensions described in the training module. The following table defines available PennPlan values. Schools and Centers will have the opportunity to request new combinations for budgeting purposes at the beginning of each planning cycle.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Available Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORG</td>
<td>All active organizations as of August. Revisions during the year upon request.</td>
</tr>
<tr>
<td>FUND</td>
<td>Commonly used funds, plus endowment and operating gift funds for which your School/Center is the responsible org as of August. Revisions during the year upon request.</td>
</tr>
<tr>
<td>OBJ</td>
<td>Object Codes normally budgeted</td>
</tr>
<tr>
<td>CREF</td>
<td>Center References used in last submission or requested</td>
</tr>
<tr>
<td>PROG</td>
<td>Programs used in last submission or requested</td>
</tr>
<tr>
<td>EMPLOYEE</td>
<td>Faculty and staff paid or encumbered from specified object codes (no Post Docs, Grad Students, Student workers or temps) as of July month end. Generic “anyone or no one” used for others.</td>
</tr>
</tbody>
</table>

The Scenario dimension allows users to choose different types of budget data to display. There are four scenarios.

<table>
<thead>
<tr>
<th>Scenario Dimension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>Actual results for a period. Actual results are loaded from the ledger and are available to be viewed through the PennHist reporting application. Actual results are loaded from the ledger on a monthly basis at month-end, and any revisions to prior months will be picked up.</td>
</tr>
<tr>
<td>Operating</td>
<td>Operating budget for a period. Operating budgets are loaded from the ledger and are available to be viewed through the PennHist reporting application. Operating budgets are loaded from the ledger on a monthly basis at month end and any revisions to prior months will be picked up.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Forecast for the Current Year. Current Year forecasts are updated by the Planning user via the PennPlan application, and are loaded on a periodic basis during the day to PennHist for reporting and analysis.</td>
</tr>
<tr>
<td>Budget</td>
<td>Budget for the Next Year and future years. Budgets are managed by the Planning user via the PennPlan application and are loaded on a periodic basis to PennHist for reporting and analysis.</td>
</tr>
</tbody>
</table>

Various budget versions will be active at the same time. Planning is a year-round activity. Schools and Centers have the ability to have a “working budget” that can be updated at any time throughout the year. The budget version that is currently available to be modified and updated is called “Working.” In addition, various snapshots of the University budget plan will be taken throughout the planning cycle and
will be available for review in PennHist. These snapshots represent the four seasons, as well as different checkpoints in the planning cycle (Fall, Winter, Spring, and Summer). As the final version, “Final” represents the budget version that is loaded to the general ledger at the end of the planning cycle. Final becomes the Schools/Centers’ Original Budget for the next academic year.

<table>
<thead>
<tr>
<th>Version Dimensions</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>The version that is being worked on. All changes take place in the “working” version.</td>
</tr>
<tr>
<td>Fall</td>
<td>The fall snapshot. A snapshot of the working budget is taken on an agreed point and frozen. This fall snapshot is used in the fall five-year planning process, and helps to establish the initial planning parameters used in the winter budget planning cycle.</td>
</tr>
<tr>
<td>Winter</td>
<td>The winter snapshot. A snapshot of the working budget is taken on an agreed upon point and frozen. The winter snapshot is used for budget meetings between the Schools/Centers and their senior management teams. This snapshot also updates the five-year budget process, and impacts the final planning parameters and budget guarantees.</td>
</tr>
<tr>
<td>Spring</td>
<td>The spring snapshot. A snapshot of the working budget is taken on an agreed upon point and frozen. The spring snapshot represents the Schools/Centers’ compliance with the budget guidance offered by their Senior managers and with the applicable parameters/guarantees.</td>
</tr>
<tr>
<td>Summer</td>
<td>The labor day submission, if any, is copied and frozen.</td>
</tr>
<tr>
<td>Final</td>
<td>The final version. The final version of the budget refers to the version that is loaded to the ledger and becomes the “Original Budget” for the subsequent budget year. The final version is also used for anything that comes from the ledger, including prior year actuals, current year actuals, and the Operating budget.</td>
</tr>
</tbody>
</table>

**Setting PennPlan User Preferences**

Planning contains a tremendous amount of data. In order to ensure the most efficient work environment possible, users should narrow the focus of the data they are reviewing. Properly setting the User Preference settings will shorten the amount of time forms take to load, and reports take to run. It is frequently easier to navigate the forms after narrowing the data entry to a smaller subset of data and then to come back and change your preferences when you are ready to work on another subset of your data. For example, rather than keeping your preference set to all of the thousands of funds, you may find that you can leave your FUND preference set to the few “Commonly Used Funds” most of the time, and change the preference only when you are budgeting spending in individual endowment and gift funds.

To change your preferences, navigate to the User Preferences form by selecting “File > Preferences > User Preferences.” Select your home ORG (HORG) for employees, an ORG or ORG Parent, a group of
funds and CREF preferences limited, at least, to your Center’s two-digit prefix. If desired, a Program preference can also be selected. Selections can be made by typing directly in the input box with the correct syntax, if known, or by selecting the appropriate value by using the magnifying glass search function.

Caution: There is a defect in PennPlan that complicates changing User Preferences. Once you are finished with a set of User Preferences from within the application forms, you must navigate back to User Preferences to change your preference to different values. The data entry form will NOT notice that you have updated the preferences to the new values if you simply return to the same form. You must navigate to a different form, let that form load, and then navigate back to the desired form in order for the new preferences to be noticed.

There is a second defect with updating User Preferences. If you return to User Preferences a second time in the same session, it will display not the preferences that are currently in effect, but the previous set. If you were returning here to go back to the previous values, you can simply save. However, if you want to make a different change, you need to specify all the values again.

Other User Preferences can be easily set using the Preferences form. Users can select their preferences for formatting numbers in PennPlan. Display options allow users to put commas in numbers for ease of reading or take them out to display more data on the screen at once. Negative numbers may be
displayed in a variety of formats, including the familiar parentheses or with a minus sign. Note that there are separate preferences for how numbers appear on forms and how they appear in print screens. Choose “format data” and “apply precision” to suppress multiple decimal places on print screens.

**Number Signage**

Number signage in the PennPlan applications matches BEN Financials. Many reports in Reports, however, have been customized to show “natural signage,” i.e., positive numbers for both revenue and for expense. Reports formatted in this fashion are generally more readable for the Trustees, senior management, and other users. You should always verify which signage convention is being used before employing a particular report.

**User Interfaces**

There are two different user interfaces available in Planning. In the default user interface, called “Advanced Mode,” users navigate through PennPlan and Reports separately (in two separate browser sessions), selecting the particular data entry forms of interest in PennPlan and the particular reports of interest in Reports. The following screen is in “Advanced Mode.”
Alternatively, individual Schools and Centers can choose to have their Planning users work in “Basic Mode.” The business office of Schools/Centers can create a user Task List, combining a series of forms, reports, instructions, and links to other URLs on the web in a specified completion order. End users can then work through the forms in the specified task list order. The sample task list “Fall Forecast” has been created by the Budget Office and assigned to all users to illustrate the power (and limitations) of Task Lists. To use a task list, select “View” toggle from “Advanced Mode” to “Basic Mode” by clicking on “Basic Mode.”
If the user has been assigned more than one task list, choose the desired task list. Then, use the buttons on the bottom of the screen to navigate through the task list.

To return to the Advanced Mode (and stop using the task list), use the View Menu to toggle back to Advanced Mode. Note that there is no way to navigate to User Preferences from within a task list.
If users need to change their preferences, they need to return to Advanced Mode to do so.

Hierarchies and Penn’s Chart of Accounts

Several of the segments in Penn’s twenty-six segment account numbers are organized within a hierarchy, which is a rank or order for given values of that segment. These hierarchies look like family trees, but they can represent any information that can be ranked or ordered.

![Diagram of hierarchy]

Descriptions of items within the hierarchy follow the logic of a family tree. Values that are ranked above other values in the hierarchy are referred to as parents (e.g., in the figure above, “Animals” is the parent of “Cats”). Values that are ranked below other values are referred to as children (e.g., “Siberian Husky” is the child of “Dogs”). Values that share the same parent are referred to as siblings (“German Shepherd” and “Collie” are siblings, because they share the parent “Dogs”).

Most budget information must be input into Planning on each forms page at the lowest level of each dimension’s hierarchy. Users must navigate each form to the lowest planning level in each dimension’s hierarchy through the pull down menus at the top of each planning form. Users can identify the correct dimension value by scrolling through the available choices listed in the pull down arrow associated with the dimension or by using the binocular search function associated with each dimension. Once all of the appropriate page dimensions have been selected, remember to press “GO” to return the correct page dimensions from the database.
Organization (ORG) Hierarchy

The ORG hierarchy is used by Schools and Centers to structure the various organizations within them, and to group together various units for reporting purposes. In order to see the ORG hierarchy for your School/Center, navigate to the “Senior BA Reporting” responsibility in BEN Financials and run a 230.SCH report, using your School or Center's topmost parent as both the low and high ORG parameter. This will list ORG Parents, and the ORGs that fall under those parents.

The top parent in each School or Center is “YYXX” where “YY” is the two-digit school code for your School (e.g., for SAS - school code “02” - the top parent is “02XX”, for Dental - school code “51” - the top parent is “51XX”).

It is not necessary to scroll through the entire list of ORG combinations to find the particular ORG that you are looking for. Click on the binocular icon, type in the ORG that you are looking for, then click the Go button.
**Fund Hierarchy**

All funds at the University are grouped into Responsibility Center Management (RCM) “fund groups” such as General Purpose Funds, Special Purpose Funds, Sponsored Research Funds, etc. A list of these fund aggregations can be found at [http://www.budget.upenn.edu/dlDocs/fund_aggregations.pdf](http://www.budget.upenn.edu/dlDocs/fund_aggregations.pdf).

To make it easier (and faster) to navigate through the funds you need, a fund category called “Commonly-Used Funds” has been added to Planning. This fund group includes the most popular funds, including, the 000000 fund, the 000007 and 000008 funds, each School’s center-specific funds, and generic endowment, grant, and gift combinations (479999, 59999x, 649999, 659999). You should set your fund preference to “Commonly Used Funds” unless you are budgeting specific endowment or gift funds.
If you want to budget specific endowments or gifts, you will need to pull up the CXxxxx fund group that they belong to in User Preferences. Deselect “Commonly Used Funds” by highlighting it and clicking it. Then select the specific fund or fund group you want. The endowment and operating gift funds are organized by responsible School or Center so that you can select only your own funds. You will first need to select parent fund group CX0012, which is all operating funds, and then drill down through CX0010 to CX0004 for endowments (choose your School) or CX0005 for gifts. Within CX0005, CX0014 is operating gifts (choose your School), and CX0015 is capital gifts (one list for the University). When you are ready to see all of your activity in any RCM fund, choose CX0012.

Remember the Hyperion software defect when manipulating User Preferences to access the different fund groups.
Program (PROG) Hierarchy

Program values are listed in numeric order. The Program dimension is University-wide and is available for use by all Schools and Centers.
**Center Reference (CREF) Hierarchy**

Center Reference values are School or Center specific. In order to identify the values that belong to a specific School or Center, the Center Reference values have been prefixed in Planning with the two-digit School/Center code. Be sure to select the Center Reference values that are specific to your own School or Center.

---

**Object Code (OBJ) Hierarchy**

Planning uses the object code hierarchy that was revised last year when planning for FY2007. This hierarchy differs from the prior hierarchy in a few very significant ways. The most significant of these changes was to move student aid previously classified as contra-revenue to student aid expense. In addition, pre-doc trainee and educational fellowships were moved from student aid expense to academic salaries.

The Object Hierarchy aggregates objects into RCM Rows and Categories, according to the University RCM format. Commonly used aggregations have been assigned K parent values that allow a user to pull all objects that are associated with a given RCM Row or set of Rows, or an RCM category. Planning allows the user to view data by K parents. A copy of the revised template, showing available K parents, is available at [http://www.budget.upenn.edu/dlDocs/RCM_template_1A.pdf](http://www.budget.upenn.edu/dlDocs/RCM_template_1A.pdf).
Budgeting Revenue and Expense

Schools and Centers can work through the process of entering forecasts and budgets in any order, working across ORGs, FUNDs, OBJs, CREFs, PROGs, and Time. The totals for a particular planning page (ORG, PROG, CREF, and FUND) are updated as changes are made. For example, if you update undergraduate tuition, the tuition total, revenue total, and operating surplus/deficit for that ORG, PROG, CREF, and Fund will be updated when the data is saved.

However, the data must be aggregated in order to see the ORG totals for all programs and center references or the School total for all ORGs or the FUND group totals. Aggregations will be automatically launched within each Penn Plan instance according to a schedule. See the Planning Web for the current schedule. Additionally, an Aggregation Business Rule may be available (see Planning website) that will allow a user to launch an aggregation. If so, the Aggregation Business Rule will be available through the Tools drop down menu within PennPlan. Choose the applicable Business Rule and press Launch.

Data Entry Forms

Click on the Forms folder icon to access the data entry forms to prepare your forecast, next year's budget, or a five-year budget. Forms are separated into two groups of folders. The first folder contains the forms needed to input Revenue and Expense forecasts and budgets. Forecast and budget data are entered on the same form at the same time.
Forms A through N separate budget entry forms by RCM category. All objects within the RCM category are available to all users through these forms, and new combinations can be budgeted.

Forms R through Z will allow the user to view an overall summary at various levels, or in some cases (form T), tweak all the existing budget lines for an ORG-PROG-CREF-FUND on a single form. These forms may be more convenient for users who are entering the same types of budget information as in prior years. New object combinations, however, cannot be created through these forms. These objects will need to be budgeted via Forms A through N.
Budgeting Personnel

PennPlan permits budgets to be constructed by employee. Planning salary data does not include any confidential biographical or demographical information. You can see budgeted salary payments, but not the salary itself. The system security for this is not as complicated or powerful as that in Salary Management, Payroll, or WESD (Web-Enabled Salary Distribution). Users will be able to see any payments they make or plan to make from their paying ORG(s), whether to employees of their home ORG(s) or other ORGs within the same PennPlan instance. For example, a School of Medicine user who pays a Dental School employee through its ORG can see only that portion of the employee’s salary it is paying. Conversely, a Dental user would not be able to see those payments made by the School of Medicine.

What Types of Personnel Are Included?

The list of employees was built in August 2006, and includes any faculty and staff paid or encumbered as of the end of July, except Post Doctoral Fellows, Graduate Students, Student Workers, and Temporary employees. Salaries for those groups are budgeted using ‘anyone or no one.’

“Anyone or No One”

In order to be able to add new lines to the system for budgeting purposes, or for cases where budgeting by person is not necessary, a placeholder called “Anyone or No One” can be used. There is an “Anyone or No One” for the University as a whole (PENNID-0001ANY) and for each home org (PENNID-org#ANY), so that salary can be budgeted for unfilled positions or as a reserve. For budgets converted into Planning
where there was no person level detail, the entire budget is posted to Org 0001’s “Anyone or No One.” (It is not possible to convert budgets to a particular home ORG because not all paying ORGs are home ORGs).

Schools and Centers were aligned within PennPlan instance to group those most likely to interface with each other in the same planning instance. None the less, some Salary payments should be budgeted across Schools that are not in the same Planning instance. “Anyone or no one” will need to be substituted for the person in these situations.

**Salary Forms**

The second forms folder provides the forms that are needed to budget all salaries. Schools and Centers have a choice. Salaries can be budgeted in the 26-digit accounting codes aggregate OR salaries can be budgeted by person. Salaries are budgeted in the aggregate using the individual “Anyone or No One” to enter salary detail into the Planning forms. Some Schools and Centers, however, desire to budget on a person level. The Planning application has been pre-populated with lists of faculty and staff for Schools and Centers who have arranged with the Budget Office to budget by person and have provided the salary data to the Budget Office in a format that can be incorporated into the Budget application. If you have any questions about this capability or would like to investigate whether or not you can use this capability, please call your Budget Office analyst.

Schools and Centers can use these forms to budget their salary payments for all employees within their School/Center and for employees of other Schools and Centers as long as they are employees of other Centers within the same PennPlan instance. The combinations of Schools/Centers within each PennPlan instance were designed to maximize the likelihood that Schools/Centers would need to reach into other Schools/Centers to budget salary payments. Salary payments for employees in other Schools/Centers will have to be budgeted using the “Anyone or No One” selection. New employee salaries also should be budgeted in this fashion.

The Single Year set of Salary forms allows users to plan the upcoming year for budgeted salaries. There is a group of forms for Academic salaries and a group for Non-Academic salaries. Each form displays a group of related object codes, and allows the user to budget new combinations by specifying ORG, PROG, CREF, and either Fund or Employee in the Page dimensions at the top of the form. The body of the form will then display either a row for every Employee (forms A and C below) in the selected home org, or a row for every Fund in Commonly Used Funds (form B below), or a row for every Object Code (forms F and G, which use the person “Anyone or No One”).

The second set of forms extends the salary budgeting capability to multiple years. The first six forms suppress missing values, and so can display only the lines that have been previously budgeted. On each
form, you specify five dimensions in the page, and the sixth dimension will appear in the rows. For example, in form A, you specify ORG, FUND, PROG, CREF, OBJ, and it will display all the budgeted employees. In form B, you specify FUND, PROG, CREF, OBJ, and Employee, and it will display all the budgeted ORGs. Form N in this group can be used to create new combinations: for any specified ORG, FUND, PROG, CREF, and Employee, all the salary object codes will be displayed, whether previously budgeted or not.

Pre-Populated Data for Forecast and Budget
Budget data were pre-populated within the application from the Spring submission. The current year forecast is initially blank. As a starting point, Schools and Centers may elect to copy all or part of the Spring budget into the forecast using the Copy Adjust function found under Tools, Business Rules. You can copy any ORG or ORG parent, for any fund or fund group parent, for any object code or object code parent, and adjust by any percentage.

Calculations for Forecast and Budget
AIF income is prepopulated based endowment market value for August as reflected in the ledger in September, and updated for the FY2008 spending rule. If you budget any planned additions or liquidations in OBJ-1710, the associated income under the spending rule will be calculated for you. In addition, there is a new Planning Assumption called “Gifts to Endowment” that you can budget in Planning. The associated income under the spending rule will be calculated for you, but will not appear
as OBJ-1710, so that you can plan for gifts to NAC 2 without showing the confusing ‘cash effect’ entries. Endowment and gift overhead is calculated based on budgeted income for funds subject to overhead. The overhead charge to individual funds will be updated when you save the budgeted income for the fund. The overhead recovery to the School is scheduled to update overnight.

Salaries are updated based on the person-level detail (see budgeting personnel above). Employee Benefits are calculated based on budgeted salaries and will continue to be calculated as new salaries are budgeted and saved on the Planning forms. The dependent tuition charge is automatically moved to the 000000 fund for grant and service centers.

**Planning Maintenance Schedule**
In Planning, some things take effect immediately, and some things wait for a specific process to run to update them. This table summarizes what happens when, based on our initial maintenance schedule. See the Planning web for an updated schedule.

<table>
<thead>
<tr>
<th>Maintenance Function</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add up all object codes for a single ORG, FUND, PROG, CREF, and if salary, Employee</td>
<td>Upon Save</td>
</tr>
<tr>
<td>Aggregate Employee, Org Parent and Fund Group totals</td>
<td>Hourly *</td>
</tr>
<tr>
<td>Feed Forecast and Budget to PennHist for Reporting/Analysis</td>
<td>Every Four Hours **</td>
</tr>
<tr>
<td>Calculate AIF income on planned gifts, or budgeted additions/liquidation</td>
<td>Upon Save</td>
</tr>
<tr>
<td>Calculate Overhead on endowment/gift fund</td>
<td>Upon Save</td>
</tr>
<tr>
<td>Calculate Overhead recovery in FUND-000000</td>
<td>Overnight ***</td>
</tr>
<tr>
<td>Calculate Employee Benefits for single ORG, FUND, PROG, CREF</td>
<td>Upon Save</td>
</tr>
<tr>
<td>Move Dependent tuition for grants and service centers</td>
<td>Overnight ***</td>
</tr>
</tbody>
</table>

* Initially, PennPln1 on the quarter hour, PennPln2 on the half hour, PennPln3 on the three-quarter hour.
** Initially, at 8:00 am, noon, 4:00 pm and 8:00 pm.
*** If necessary, the Budget Office can run this during the day, upon request.

**Using Reports**
Launch Reports from the Budget Planning web page. It is often helpful to open a new Internet Explorer window so that both PennPlan and Penn Hist are available at the same time from your desktop. Password security and browser settings are identical to PennPlan.
Setting Report Preferences

Reports allow you to set preferences for reports, similar to the preferences that were set in PennPlan. To set preferences in Reports, select “File -> Preferences” from the main menu. There are two options available: “General” and “Set Up User Point of View.” Both bring up dialog boxes with options. The “General” tab looks like this.

The “General” preferences allow you to set preferences for what reports look like on the screen, including whether you prefer to preview them in PDF or HTML, what character to use for thousands and decimal separators, general color schemes, and what version of office application you use.

The “Set Up User Point of View” dialog box requires you to pick each of the three data sets (PennPlnX RevExp, PennPlnX Salary, PennHist), and then specify the default parameters you want to use when running any reports that use that dataset. Note that in Reports (as opposed to in PennPlan) you will see ORGs in the list that you don’t have access to, but if you select them, the data appears as all missing or zeroes to you.
Running Reports

Running reports merely requires navigating to the appropriate report within the repository, double-clicking on the report, entering the appropriate parameters, and selecting “OK.”